Dell EMC OpenManage Release Notes
Version 9.1

This document describes the new features, enhancements, and fixed issues in Server Administrator 9.1.

Topics:

- Release Type and Definition
- Importance
- Platforms Affected
- What is Supported
- What's new in this release
- Important Notes
- Known Issues for Server Administrator

Release Type and Definition

Server Administrator

This document contains updated information for the Dell EMC OpenManage Server Administrator User's Guide and any other technical documentation included with Server Administrator.

NOTE: System Management software, including the Server Administrator (Server Administrator), is available only on the Dell EMC Systems Management Tools and Documentation software.


You can access the documentation from dell.com/openmanagemanuals.

Version

9.1

Release Date

December 2017
Importance

RECOMMENDED: Dell recommends applying this update during your next scheduled update cycle. The update contains feature enhancements or changes that will help keep your system software current and compatible with other system modules (firmware, BIOS, drivers and software).

Platforms Affected

For a complete list of supported Dell PowerEdge systems and supported Operating systems, see the Dell EMC OpenManage Systems Software Support Matrix available in the required version of OpenManage Software at dell.com/openmanagemanuals.

What is Supported

Hardware Requirements

- Minimum of 2 GB RAM
- Minimum of 512 MB free hard drive space
- Administrator rights
- Monitor with a minimum screen resolution of 800 x 600. The recommended screen resolution is at least 1024 x 768

Software Requirements

- Supported operating system and web browser.
- TCP/IP connection on the managed system and the remote system to facilitate remote system management.
- Supported systems management protocol standard. For more information, see Dell EMC Supported Systems Management Protocol Standards.
- The Server Administrator Remote Access Controller service requires remote access controller (RAC) to be installed on the managed system. For more information on the software and hardware requirements, see the relevant Integrated Dell Remote Access Controller User’s Guide.

NOTE: The RAC software is installed as part of the Typical Setup installation option provided the managed system meets all of the RAC installation prerequisites.

- The OpenManage Server Administrator Storage Management Service requires Server Administrator to be installed on the managed system. For more information on the software and hardware requirements, see the Dell EMC OpenManage Server Administrator Storage Management User’s Guide.
- Microsoft Software Installer (MSI) version 3.1 or later.

NOTE: Server Administrator software detects the MSI version on your system. If the version is earlier than 3.1, the prerequisite checker prompts you to upgrade to MSI version 3.1. After upgrading the MSI to version 3.1, you may have to reboot the system to install other software applications such as Microsoft SQL Server.
What’s new in this release

- Support for servers from 11th generation till 14th generation.
- Supported network cards:
  - Emulex LightPulse LP31000-M6-D 1-Port 16Gb Full Height Fibre Channel Adapter
  - Emulex LightPulse LP31000-M6-D 1-Port 16Gb Low Profile Fibre Channel Adapter
  - Emulex LightPulse LP31002-M6-D 2-Port 16Gb Full Height Fibre Channel Adapter
  - Emulex LightPulse LP31002-M6-D 2-Port 16Gb Low Profile Fibre Channel Adapter
  - Mellanox ConnectX-4 Dual Port EDR VPI QSFP28 Low Profile Adapter
  - Mellanox ConnectX-4 Dual Port EDR VPI QSFP28 Full Height Network Adapter
  - Mellanox ConnectX-4 Single Port EDR VPI QSFP28 Low Profile Adapter
  - Mellanox ConnectX-4 Single Port EDR VPI QSFP28 Full Height Network Adapter
  - Harbor Channel - Intel(R) Ethernet 25G 2P XXV710 Adapter (25GBE PCIe Adapter)
  - QLogic Duluth - FH – 10Gb Dual Port BT Arrowhead based Converged Network Adapter QL41162HFRJ-DL-BK (without optics)
  - QLogic Duluth – LP - 10Gb Dual Port BT Arrowhead based Converged Network Adapter QL41162HLRJ-DL-BK (without optics)
  - QLogic Dunkirk - 10- FH – 10Gb Dual Port SFP Arrowhead based Converged Network Adapter QL41112HFCU-DL-BK (without optics)
  - QLogic Dunkirk - 10– LP - 10Gb Dual Port SFP Arrowhead based Converged Network Adapter QL41112HLCU-DL-BK (without optics)
  - QLogic Dunkirk - FH – 10/25Gb Dual Port SFP28 Arrowhead based Converged Network Adapter QL41262HFCU-DL-BK (without optics)
  - QLogic Dunkirk – LP - 10/25Gb Dual Port SFP28 Arrowhead based Converged Network Adapter QL41262HLCU-DL-BK (without optics)
  - QLogic Dundee - FH – 10Gb Quad Port BT Arrowhead based Converged Network Adapter QL41164HFRJ-DL (without optics)
  - QLogic Dundee – LP - 10Gb Quad Port BT Arrowhead based Converged Network Adapter QL41164HLRJ-DL (without optics)
  - QLogic Delray - FH – 10Gb Quad Port SFP Arrowhead based Converged Network Adapter QL41164HFCU-DL (without optics)
  - QLogic Delray – LP - 10Gb Quad Port SFP Arrowhead based Converged Network Adapter QL41164HLCU-DL (without optics)
  - QLogic Dardanelle – rNDC - 10/25Gb Dual Port SFP28 Arrowhead based Converged Network Adapter QL41262HMCU-DL (without optics)
  - QLogic Darwin – rNDC - 10Gb Dual Port BT Arrowhead based Converged Network Adapter QL41164HMRJ-DL (without optics)
  - QLogic Dresden – rNDC - 10Gb Dual Port SFP Arrowhead based Converged Network Adapter QL41164HMCU-DL (without optics)
  - QLogic Dartmouth – rNDC – 1Gb & 10Gb 2+2 Port BT Arrowhead based Converged Network Adapter QL41264HMCU-DL-BK (without optics)
  - QLogic Dunedin – rNDC – 1Gb & 10Gb 2+2 Port SFP Arrowhead based Converged Network Adapter QL41264HMCURJ-DL-BK (without optics)
- Supported web browsers:
  - Google Chrome version 57
  - Google Chrome version 58
  - Mozilla Firefox version 52
  - Mozilla Firefox version 53
  - Internet Explorer 11
  - Internet Explorer 10
  - Safari version 10.x
- Supported features:
  Server Administrator
  - Support for Java Runtime Environment 8 Update 131.
  - Upgraded Tomcat version to 8.5.15.
  - Minimum supported TLS version is TLSv1.1.
Encryption Ciphers list has been updated as per OWASP Apache Tomcat Security Standards.

- Supports NVMe (Non-Volatile DIMM) monitoring in PowerEdge 14G servers.
- Supports System Configuration Lockdown Mode in PowerEdge 14G servers.
- Supports "Full Power Cycle" capability under BIOS settings which enables DC Power cycle followed by AC Power cycle of the auxiliary components (includes iDRAC, CPLD, etc.).
- Server Administrator Shared Service which is used to invoke the Inventory Collector would be disabled by default during installation of Server Administrator. In order to invoke Inventory Collector explicitly, customer should enable it through Server Administrator command line interface.
- Server Administrator ESXi VIB leverages the ESXi OS Live installation capability so that a host OS reboot will not be required post installation or removal of the VIB.

### Storage Services

- Support for "Prepare To Remove" operation for PCIe SSD devices through PERC S140 controller.
- Support for setting the critical threshold and warning threshold for available spare and alert generation.
- Support for the following Intel Clifdale devices are added: P4500 and P4600
- Support for CAPONE V2 (BOSS) device.
- Support for Ubuntu 16.04.3 operating system.

**NOTE:** For the list of supported operating systems and Dell servers, see the [Dell EMC OpenManage Software Support Matrix](https://www.dell.com/support/home/us/en/04/solutions/operatingsystems) in the required version of OpenManage Software at [dell.com/openmanagemanuals](https://www.dell.com/support/home/us/en/04/solutions/operatingsystems).

**NOTE:** For more information about any features, see the [Dell EMC OpenManage Server Administrator Online Help](https://www.dell.com/support/home/us/en/04/solutions/software/operating-systems).
• If you have to uninstall and reinstall the operating system SNMP service, then reinstall Server Administrator, so that the Server Administrator SNMP agents are registered with the operating system SNMP agent.

• Server Administrator Device Drivers for Linux: Server Administrator includes two device drivers for Linux: Systems - Management Base Driver (dcdbas) and BIOS Update Driver (dell_rbu).

• Server Administrator uses these drivers to perform the systems management functions. Depending on the system, the application loads one or both of these drivers. These drivers have been released as open source under the GNU General Public License v2.0. They are available in Linux kernels from kernel.org starting with kernel 2.6.14.

• CMC USB ports attached to a blade are not enumerated by Server Administrator.

• Except for AC power cord traps, SNMP traps for server instrumentation are not generated when the state of the device sensor changes from unknown to normal. While migrating the chassis of a PowerEdge M520, M620, or M820 server running Windows operating system from M1000e to VRTX chassis, reboot the server after the new drivers are detected and installed. If not, the DSM SA Data Manager service crashes on startup and OMSA fails. (BITS125071)

Notes for Storage Management Service

Detailed information on the Storage Management Service is available in the Storage Management Service online help. After installing and launching Server Administrator, you can access the Storage Management Service online help by selecting the Storage or lower-level tree object and clicking the Help button on the global navigation bar.

Notes for Remote Access Service

• The remote access service is available on supported systems only in this release. It enables remote access to a server that has lost its network connection or that has become unresponsive. In the current release of Server Administrator, the Remote Access Service uses Integrated Remote Access Controller (iDRAC).

• iDRAC also has its own CLI that is accessed through the racadm command. You can add racadm commands to a batch or script file to automate various user tasks. To limit the stress load on the managed system, and RAC, add sleep or delay commands of one or two seconds between the individual racadm commands.

• On systems prior to 11th generation PowerEdge server, Server Administrator slot page displays iDRAC information, but on 12th generation or later PowerEdge servers, the slot page does not display any iDRAC7 information.

Known Issues for Server Administrator

This section provides information on open issues and resolutions with this release of Server Administrator.

Issues of Server Administrator on VMware ESX Operating Systems

• DF354388: Remote Server Administrator Web Server connection to a managed node hangs, if a redundant virtual disk containing syslog dumps fails.
  – If you configure the syslog to store logs on a remote virtual disc (VD), and remove the remote VD without reconfiguring the syslog to a valid location, the Server Administrator web server screen stops responding.
  – To continue using the Server Administrator Web server, restart the management services on the managed node.

• BITS072069: On ESX/ESXi Operating Systems, Server Administrator configuration changes are not persisted after an unclean shutdown.
  – If the server abruptly reboots, configuration changes to Server Administrator Preferences are not retained on VMware ESX or ESXi operating systems. Once an hour, VMware runs a scheduled backup to update any configuration changes to the installed applications (VIBs). For more information, refer to the Knowledge Base article at - http://Kb.vmware.com/kb/2001780

• BITS119710: On systems running the VMware ESXi operating system, the TOE status of a network controller is not available.

• On ESXi 5.5 and later operating systems, NIC cards using Native drivers display limited information on Server Administrator.

• JIT-59888: It is recommended to wait several minutes after an ESXi host has completed bootup before attempting login from a remote OMSA web GUI. Otherwise the web login will fail as SFCB services load OMSA on the ESXi host and this may also cause some loss of
semaphores from the hypervisor’s semaphore pool. If the ESXi system log indicates "no more semaphores available" then a suspension of virtual machines and complete reboot of the ESXi host is recommended to prevent overall hypervisor stability issues.

- **JIT-72246**: After uninstalling the Live VIB on ESXi OS 6.0 U3 and later systems, some of the folders including INI files may not be removed during cleanup in the /etc/cim/dell and /opt/dell folders.
  However, these folders do not cause any functional limitation.
- **JIT-73658**: In R940 server, AIC placed in slot 3 shows as slot 0 in OMSA 9.1.0 installed on ESXi 6.5 U1 OS.
  Restart OMSA service on the ESXI system to enumerate the Slot instances properly.

### Issues of Server Administrator on Red Hat Enterprise Linux Operating Systems

- When starting Server Administrator from the Red Hat Enterprise Linux console, kernel log messages may appear. To avoid these messages, perform the following steps:
  a. Edit the /etc/sysconfig/syslog file and modify KLOGD_OPTIONS to KLOGD_OPTIONS="-c 4".
  b. Restart syslog by executing /etc/init.d/syslog restart.

### Issues of Server Administrator on all Linux Operating Systems

- **DF275424** and **DF332775**: Domain users unable to login to Windows MN from Linux Web Server.
  - Negotiate authentication is not supported while remotely managing a Windows-based managed node from a Linux-based Server Administrator Web server. If you run the Server Administrator Web server on a Linux based operating system and try to manage a remote Windows managed system as a domain user, a login failed message is displayed.
  - You can manage a Windows/Linux- based managed system remotely from a Windows-based Server Administrator Web server.
- **BITS119710**: On Server Administrator, you cannot use Windows domain user credentials to manage a system running Linux. If you try to do, a login failed message is displayed.
- **JIT-57929**: Server Administrator Linux installer, still carries install packages of RAC4 and RAC5 RPMs which are deprecated.
- **JIT-63679** On systems running Linux operating systems, does not allow the Inventory collector to run after successfully updating the DUPs locally, remotely or even restart the shared service due to SELinux security restrictions.
  Workaround for this issue is: Change SELinux settings value to "Permissive" from "Enforcing". The SELinux config file is available at /etc/selinux/config.

### Issues of Server Administrator on Microsoft Windows 2003 Operating Systems

- **BITS194536**: While trying to upgrade to OM 8.1 from OM 7.4.0.2 in systems running Microsoft Windows 2003 operating system, if the upgrade fails with the error **Error 1306**, another application has exclusive access to the file C:\WINDOWS\invcol.tmp. Shut down all other applications, then click Retry do the following before upgrading again: End the invcol.exe process in the Windows task manager utility and delete invcol.tmp from C:\Windows folder.
  You can ignore the following warning message: A provider, omprov, has been registered in the WMI namespace, Root\CIMV2\Dell, to use the LocalSystem account. This account is privileged and the provider may cause a security violation if it does not impersonate the user requests correctly. This can be ignored as the Managed Object Format file used to register the provider ("omprov") states that the provider only reads the inventory data; it does not perform any functions on the server that require user impersonation.
When running Server Administrator, crypt32.dll errors may be written to the operating system Application Event log. This issue occurs due to the Update Root Certificates component, which is installed by default as part of Windows Server 2003 installation. For more information on this component and reasons for errors, see the following articles on the Microsoft website:

- http://support.microsoft.com/default.aspx?scid=kb;en-us;317541

There are two options to avoid these errors from being written to the Event log:

- Uninstall the Update Root certificates component as described in the first knowledge base article mentioned above.

  **NOTE:** This procedure may affect other programs as discussed in the article.

- Install the Server Administrator certificate as a trusted certificate.

  **NOTE:** This procedure may still prompt you to accept the certificate when you log in to Server Administrator, but will prevent the crypt32 errors from being logged to the Event log.

- **DF94201**: When you double-click the Server Administrator icon on your desktop, a dialog box may appear, prompting you to enter credentials in Microsoft Internet Explorer for certain settings. Two possible workarounds are available for this issue: You can cancel the dialog box and enter the credentials to access Server Administrator, or enable SSO (Single Sign On) by changing the browser settings.

  To enable SSO on Internet Explorer:
  a  Cancel the dialog box.
  b  Go to Tools > Internet Options > Security > Trusted sites > Custom Level.
  c  Under User Authentication Logon option, change the settings to Automatic logon with current user name and password.
  d  Add the server URL to Trusted sites under Tools > Internet Options > Security > Trusted sites > Sites.

- **BITS216267**: Upgrading Server Administrator from 8.1 to 8.2 and then restarting DSM Connection Service after changing any server preference values would display a crash message in Windows Event Viewer’s application log. This crash message is a false message and can be ignored.

- **JIT-26671**: On Server Administrator, the Duplex capability value is displayed as “Unknown” in Broadcom Extreme E-Series Network interface card in the NIC properties.

**Issues of Server Administrator on All Microsoft Windows Operating Systems**

- Perform all Server Administrator CLI commands from a 32-bit Windows command prompt. You can access the 32-bit command prompt by clicking Start > Programs > Accessories > Command Prompt or by clicking Start > Run and then typing cmd.exe. Attempts to run the CLI commands from the DOS command prompt may generate unpredictable results.

- The DSM Server Administrator Connection Service may hang on system startup if both Oracle and VERITAS Backup Exec are installed on the system. To manually start the DSM Server Administrator Connection Service on a system running Windows, click Start > Programs > Administrative Tools > Service, right-click DSM Server Administrator Connections Services and select Start.

- You may not have appropriate privileges on the Server Administrator GUI if you:
  - Belong to an Active Directory group that is part of another group.
  - Try to launch Server Administrator using the desktop icon when single sign-on is enabled.

  Broadcom architecture has a split driver implementation - evbdx.sys and bxnd60x.sys.
  - evbdx.sys is the Virtual Bus Driver (VBD); also called the Base Driver
  - bxnd60x.sys is the driver for the Broadcom NDIS device.

  Microsoft Device Manager reports both the drivers, but Server Administrator displays only the driver details specific to the VBD device.

- **BITS080169**: Documentation for Power Supply alerts mentions only AC power supply, but the alerts are valid for both AC and DC power supplies.

- **BITS054513**: On a system running Windows, while running CLI commands using telnet from a system running Linux, the telnet session may terminate if the amount of data being transferred is huge.

  **Workaround:** Redirect the CLI output to a text file and use the `type` command to view the output.
• **DF551365**: Server Administrator does not display the IP Address for Network Adapters that are used for virtual machines

**Description**: In a Microsoft Hyper-V environment, the Server Administrator Network page may indicate network adapters that are connected to a network and display Ethernet statistics but, the IP address is displayed as 'Unknown'. This is because Hyper-V virtualizes adapters that are bonded to its virtual switch. The Server Administrator only discovers physical network adapters and displays their IP addresses that are fully-controlled by the operating system and not by hypervisors.

• **BITS080696**: Windows No Instance(s) Available is reported for Dell_CMApplication class data To get the data for Dell_CM* wmi classes query, first query any one of the Dell_* classes.

• **JIT-58840**: On systems running Windows 10 operating system, the operating system is incorrectly displayed within OpenManage Server Administrator as Windows 2016 Server Operating System.

• **BITS129139**: On systems running Windows operating system, the command prompt closes if you run the following commands on any Dell PowerEdge systems:
  - `omconfig system platformmevents event=systempowerfail action=pwrpowerreduction`
  - `omconfig system platformmevents event=systempowerwarn action=pwrpowerreduction`

**NOTE**: The commands are supported only on 10th generation of PowerEdge servers.

• **DF94201**: When you double-click the Server Administrator icon on your desktop, a dialog box may appear, prompting you to enter credentials in Microsoft Internet Explorer for certain settings. Two possible workarounds are available for this issue: You can cancel the dialog box and enter the credentials to access Server Administrator, or enable SSO (Single Sign On) by changing the browser settings. To enable SSO on Internet Explorer:
  - Cancel the dialog box.
  - Go to "Tools" -> "Internet Options" -> "Security" ->"Trusted sites" -> "Custom Level."
  - Under "User Authentication Logon" option, change the settings to "Automatic logon with current user name and password".
  - Add the server URL to Trusted sites under "Tools" -> "Internet Options" -> "Security" ->"Trusted sites" -> "Sites".

• **JIT-26671**: On Server Administrator, the Duplex capability value is displayed as “Unknown” in Broadcom Extreme E-Series Network interface card in the NIC properties.

### Issues of Server Administrator on Microsoft Windows 2008 Operating Systems

• **DF103661**: Microsoft Windows Server 2008 - Alert Action > Execute Application

For security reasons, Microsoft Windows Server 2008 is configured to not to allow interactive services. When a service is installed as an interactive service on Microsoft Windows Server 2008, the operating system logs an error message in the Windows System log about the service being marked as an interactive service. When you use Server Administrator to configure Alert Actions for an event, you can specify the action to execute an application. For interactive applications to be executed properly for an Alert Action, the DSM Server Administrator Data Manager Service must be configured as an interactive service. Examples of interactive applications comprise applications with a Graphical User Interface (GUI) or that prompt users for input in some way, such as the `pause` command in a batch file. When Server Administrator is installed on Microsoft Windows Server 2008, the DSM Server Administrator Data Manager Service is installed as a non-interactive service, which means that it is configured for not interacting with the desktop directly. If an interactive application is executed for an Alert Action in this situation, the application is suspended awaiting input from the user, but the application interface or prompt is not visible to the user. The application interface or prompt is not visible even after the Interactive Services Detection service is started. For each execution of the interactive application, there is an entry for the application process in the Processes tab in Task Manager. If you want to execute an interactive application for an Alert Action on Microsoft Windows Server 2008, you must configure the DSM Server Administrator Data Manager Service to be allowed to interact with the desktop. To allow interaction with the desktop, right-click on the DSM Server Administrator Data Manager Service in the Services control panel and select Properties. In the Log On tab, enable Allow service to interact with desktop and click OK. Restart the DSM Server Administrator Data Manager Service for the change to be effective. When the DSM Server Administrator Data Manager Service is restarted with this change, the Service Control Manager logs the following message to the System log: The DSM Server Administrator Data Manager Service is marked as an interactive service. However, the system is configured to not allow interactive services. This service may not function properly. This change allows the DSM Server Administrator Data Manager Service to execute...
interactive applications properly for an Alert Action. Also, make sure the Interactive Services Detection service is running, to see the interface or prompt displayed by the interactive application. Once these changes are made, the operating system displays the Interactive services dialog detection dialog box to provide access to the interactive application interface or prompt. After upgrading Windows Server 2008 x64 to Windows Server 2008 x64 with Server Administrator installed, the application UI does not display all the expected instrumentation pages. The Server Administrator installation must be repaired. Go to Start > Settings > Control panel > Add Remove Programs > Select Change on the Server Administrator installation and select the Repair option to correct the issue.

- **DF330800**: Server Administrator Web server local user login fails on the Windows 2008 R2 Managed Node. When a Windows 2008 R2 Managed Node is added to a domain, logging in from any Server Administrator Web Server to that Windows 2008 R2 Managed Node will fail with local user or local power-user credentials. Only the credentials of a local Administrator or Domain user will work, with a prerequisite that all required winrm configurations have been applied.

### Issues of Server Administrator on Microsoft Windows 2012 Operating Systems

- **BITS068231**: On Windows Server 2012 with Server Administrator (32-bit), Base Memory Address and IRQ values are not available for any Network Interface Cards.

### Issues of Server Administrator on All Supported Operating Systems

- **BITS107804**: On PowerEdge R210 II and T110 II servers, clearing the Shutdown OS First check box and performing a reboot using the ‘Reboot’ option does not reboot the servers. After performing these steps if you refresh the Page, the options on the Remote Shutdown page are not displayed.

- On Dell PowerEdge T110 II systems, the following Server Administrator BIOS settings are not consistent with the F2 BIOS setup settings:
  - Watchdog timer: Server Administrator displays the option as disabled, but F2 BIOS allows to change the setting.
  - Embedded Video Controller: Server Administrator provides options to enable or disable, but in F2 BIOS the option is grayed out.
  - TPM Security: Server Administrator does not allow to change the settings, but F2 BIOS allows to change the settings.
  - System Profile State: Server Administrator does not allow to make changes, but F2 BIOS allows to make the changes.
  - Memory Testing: Server Administrator does not support this feature, but F2 BIOS supports this feature.
  - SRIOV option: Server Administrator does not display this information, but F2 BIOS displays this feature.

- Due to non-availability of resources, inventory collector may terminate unexpectedly and restart. If this occurs, the folder C:\Temp \invcol can be deleted if required.

- After installing Server Administrator from the command prompt, typing an omreport or mconfig command from the same prompt can cause an error. Open a new command prompt window and type commands.

- If the command log page in the Server Administrator GUI displays an error message indicating that the XML is malformed, you must clear the command log from the CLI using the omreport system cmdlog action=clear command.

- After a Reset to Defaults operation of the Integrated Remote Access Controller, the first user configuration, operation fails if it is a single-user configuration item (such as enabling or disabling a user or changing user name). Always change a combination of two-user configuration items (such as enabling or disabling a user and changing user name) concurrently during your first configuration operation.

- While typing the command omreport system version -outc <filename>, ensure that you specify an absolute path name for the output file; else, the output file is empty. For example, c:\out.txt.

- Typing omreport system esmlog/alertlog/cmdlog -fmt tbl command on the CLI can result in XML parsing errors if the size of the log is large. Use the GUI or the omreport system esmlog/alertlog/cmdlog CLI command to view the contents of the log.

- For complex omconfig CLI commands that contain multiple set commands in one command line, the CLI may report a success status for the command even if a part of the command failed. To avoid this issue, run only one set command per command line. The current settings can be confirmed by performing the corresponding omreport command.

- Some complex omconfig CLI commands that contain multiple set operations have been modified to avoid the above problem. While running a CLI command if the message, Error! Illegal combination of parameters is displayed, modify your command into several simpler commands. Each command should change only one setting.
- When running Server Administrator on a system with a traditional Chinese operating system, the application pages are displayed in simplified Chinese. To view the Server Administrator pages in English, go to your browser language preference page and change the language to English.

- Log files saved from Server Administrator are saved in zip format. It is recommended that you open this zip file using WinZip. Windows Server 2003 or Windows XP embedded Compressed (zipped) Folder utility is not recommended.

- After configuring BIOS settings on certain systems, a second reboot may be required for the Server Administrator to display the updated BIOS settings properly.

- If you import an invalid root certificate into Server Administrator, using Preferences > General Settings > Web Server > X.509 Certificate, and try to log on to the application after restarting the Web server, a blank page is displayed. To fix this issue, restore your original keystore.db file before importing a valid root certificate. To restore the keystore.db file, use both the basic operating system commands and the Server Administrator Command Line Instrumentation (CLI).

Perform the following steps from your operating system command line:

a. Type: `omconfig system webserver action=stop`  
b. Locate the `keystore.db.bak` file. The default path is `C:\program files\dell\SysMgt\apache-tomcat\conf`.

c. Copy `keystore.db.bak` to `keystore.db`

d. Type: `omconfig system webserver action=start`

- A temperature drop below a minimum failure threshold does not cause a system reset even if this alert action is set.

- Clicking the Back and Refresh buttons on the browser may not display the correct page regarding the Server Administrator component tree, tabs, tab menus, or help, as Server Administrator has been designed with limited functionality to reduce overhead. Full feature capabilities of the Web browser such as Back, Refresh, and Open in New Window may not be supported.

- Selecting the boot sequence under the BIOS Setup tab does not re-enable boot devices that have been disabled in the System Setup Program, earlier.

- The links on the Server Administrator home page may not work after repeated random clicking. To resolve this issue, refresh the browser by pressing <F5> or click the browser Refresh button.

- All unsecured HTTP requests to Server Administrator receive an invalid response. Server Administrator runs only one instance of the Web server, which is secure. Make all connections through `https://<ip address>:<port number>`. Any `http://<ip address>:<port number>` request for connection with the server receives an invalid response.

- If the web browser used with Server Administrator does not display a page or perform an action, make sure that the browser is in online mode. To go online, perform the following:
  - In Internet Explorer, on the menu bar, click File and clear the Work Offline option. When Work Offline is selected, a check mark is displayed to the left of the option on the File menu.

- If Internet Explorer prompts you to Work Offline, Connect, or Try Again, always select Connect or Try Again. Do not select Work Offline.

- In Internet Explorer, on the menu bar, click File and clear the Work Offline option. When Work Offline is selected, a check mark is displayed to the left of the option on the File menu.

- If Internet Explorer prompts you to Work Offline, Connect, or Try Again, always select Connect or Try Again. Do not select Work Offline.

- While setting dates in the Asset Information section of the Server Administrator home page, the current time is appended to the date. While setting dates with the CLI, the appended time is noon.

- On some systems, temperature probe values and settings are only supported for whole degrees, not tenths of a degree. On those systems, setting a fractional value for the minimum warning temperature threshold results in the set value being rounded off to the next whole number value. This behavior may cause the minimum warning threshold to have the same value as the minimum failure threshold.

- If you close the browser using the Close button on the browser or log off from the operating system, the Server Administrator session is not terminated. This session is listed in the Session Management page until the session time out occurs, or DSM SA connection service is restarted, or the operating system is rebooted.

- If you change the operating system Time Zone to a new time zone, Server Administrator session management does not display the time in the new time zone specified. Restart Server Administrator to display the accurate time for the time zone in the Session Management page.

- **DF78425**: The Server Administrator Auto Recovery feature may execute the configured action before the time interval when the system is under heavy stress.

The Auto Recovery feature can be set to execute an action (For example, system reboot) to recover a hung system. Since the Auto Recovery timer is now an application-level timer instead of a kernel-level timer, heavy resource stress on the system may result in an inaccurate measurement of a short keep alive interval (less than 120 seconds), and the configured action may be triggered. The issue is
more prevalent in systems that have only one CPU with hyper-threading unsupported/disabled or systems that are subjected to persistent stressful conditions such as, resource depletion and CPU running at 100% usage with significantly more threads than normal usage.

The Auto Recovery feature is not enabled by default. If the Auto Recovery feature has been enabled, increase the System Reset Timer value to at least 120 seconds.

- Using the Internet Explorer browser, if you install Server Administrator on a system that includes an underscore in its host name, you must use the IP address of the target system in the browser URL to launch Server Administrator, as Host names with underscores are not supported. For example, (assuming Server Administrator is listening on port 1311): https://192.168.2.3:1311.

For more information, see the following article on the Microsoft website: [http://support.microsoft.com/kb/312461](http://support.microsoft.com/kb/312461)

- **DF152755**: The Server Administrator GUI does not respond when the alerts log has many events. If the Alert Log contains several entries and if you try to navigate to another page, the Server Administrator GUI may take about 30 seconds to display the content.
- **DF172125**: Power monitoring probes are displayed on certain systems that do not support power monitoring. On certain systems that do not support power monitoring, Server Administrator reports the two platform event filters related to a power monitoring as **System Power Probe Warning** and **System Power Probe Failure**. These two filters are not supported on these systems. That is, you can view and configure these filters, but no action is taken.
- **DF185770**: Primary User Telephone Number does not accept symbols. On Server Administrator, under **Asset Information > System Information > Primary User Telephone Number** configuration allows only alphanumeric characters.
- The selection of default option for the front panel LCD in Server Administrator displays the Model Name whereas the default is a Service Tag on the physical LCD.
- If Server Administrator does not respond or is locked to your selections on the component tree, perform the following steps:
  a. Click **Preferences**. The Preferences page appears.
  b. Click **Server Administrator**. The items on the front page may respond to your click.
- **DF277439**: Persistence of Configuration and Log File Changes in VMware ESXi: On systems running the VMware ESXi operating system, the file system is ramdisk. Modifications made to the files within the file system are generally not persistent across reboots, with the exception of designated configuration and log files. These files are updated to the disk periodically and on system shutdown. If the system is reset without a graceful shutdown before the updated to the designated configuration are made and before log files are updated to the disk, the changes are lost.

The following is an example of the effect of this behavior:

- On certain systems, the first time that the thresholds for a probe are changed after Server Administrator is installed; the current threshold values for that probe are saved as the default threshold values by writing the values to a configuration file. When **Set to Default** is performed after the first change of the thresholds, Server Administrator sets the threshold values to the values that were saved in the configuration file as the default. If the system running the VMware ESXi operating system is reset without a graceful shutdown before the changes to the configuration file are updated to the disk, the user-defined thresholds become the default thresholds.
- **DF315853**: Some Server Administrator CLI commands, function properly only when run from the elevated console window. It is recommended that you use the elevated console for running the CLI.
- Due to some limitations, you cannot log on simultaneously to multiple browser instances/tabs using SSO login, as only one session remains active while the other sessions expire.
- **DF489034**: Intel TXT configuration fails due to Virtualization technology dependency.
- If the current Virtualization Technology attribute setting is **Disabled** (Virtualization Technology is part of the Processor Settings group on the BIOS setup page); the Intel TXT attribute configuration fails on the Server Administrator user interface (**System > Main System Chassis > BIOS > Setup > System Security**). To resolve this issue, configure Virtualization technology setting to **Enabled** and reconfigure the Intel TXT attribute, if it is configurable.
- **DF549057**: When an operating system is installed through USC, the BIOS attributes in Server Administrator are displayed as read-only. You can edit the BIOS attributes 18 hours after the operating system installation.

**Workaround**: To enable editing of the Server Administrator BIOS attributes, launch Lifecycle Controller while booting.

- **BITS040169**: In case of Boot/HDD/UEFI sequence, if they are read-only, then toggle buttons (+ and -) and submit button are not visible. On the BIOS setup page, dependencies may exist between the various attributes for Bios settings. Setting an attribute value may change the state of the dependent attributes to non-editable or editable. For example, changing the Boot Mode to UEFI from the Boot Settings page does not allow you to configure the Boot or Hard-Disk Drive Sequence in the BIOS Boot Settings page. When the page is non-editable, the toggle buttons on the page allows toggling the order of the boot sequence. However, settings cannot be configured since **Apply** button will not available to submit the settings.
• BITS050574: On 11th generation and 12th generation of PowerEdge servers running the Linux OS, the omreport system summary command displays **RAC Command Interface** as 7.1.0. "RAC Command Interface" is a DRAC4 RPM and its version is 7.1. It is installed as a dependent package for iDRAC6 and iDRAC7 Command Interface packages.

• If a new certificate imported to Server Administrator is not active after restarting the Web server, restore the previous certificate. To restore the previous certificate, do the following:
  a. Stop the Web server.
  b. Perform one of the following as applicable:
     - On systems running Windows:
       - Delete the file keystore.db at <installed directory>\Dell\SysMgt\apache-tomcat\conf\keystore.db
       - Rename the file keystore.db.bak at <installed directory>\Dell\SysMgt\apache-tomcat\conf\keystore.db

     - On systems running Linux:
       - Delete the keystore.db file at /opt/dell/srvadmin/lib64/openmanage/apache-tomcat/conf
       - Rename the keystore.db.bak at /opt/dell/srvadmin/lib64/openmanage/apache-tomcat/conf keystore.db
  c. Start the Web server.

• BITS078118: On 12th generation of PowerEdge servers with specific versions of iDRAC, you cannot set the platform event alert actions (reboot, shut down, and so on) through Server Administrator. Set the alert actions for the events through iDRAC GUI.

• BITS144583: On Mozilla Firefox 21 or later, the Quit browser option does not work after logging out from Server Administrator. To close the browser or tab, you must manually close the Firefox browser tab.

• BITS177670: On Chrome 38 or later, the Quit browser option does not work after logging out from Server Administrator. To close the browser or tab, you must manually close the Firefox browser tab.

• On PowerEdge T430, C4130, and R220 II, with PERC S130 backplane which does not support the blink/unblink operation for disks available on this configuration.

• BITS256832: The default factory IP for an iDRAC is “192.168.0.120” or “192.168.0.*”, which indicates that the iDRAC IP is not configured by the user. However, if you choose to configure the default factory IP (static or DHCP) as your iDRAC IP, then the “Not Configured” value for “iDRAC Network Settings” displayed on the OMSA “System Summary” page can be ignored. Note: On rack and tower systems, the default factory IP for iDRAC is “192.168.0.120”. On modular systems, the default factory IP range for iDRAC is “192.168.0.*”, where “*” can be any value from 0 to 255.

• BITS265922: The DSM SA Connection will fail to start if Java Runtime Engine 1.8.0 or newer is installed and specified as the “System JRE” in Preferences of the Server Administrator web GUI. OMSA 8.3 and older is currently not compatible with Java 1.8 or newer. To recover to the default Bundled JRE setting so that the web service starts again, enter the following command line: omconfig preferences webserver attribute=setjre jreversion=bundled

• BITS260330/BITS260451: Restart the data manager service, after Intel NIC driver update or NVIDIA graphics driver update is performed.

• JRT-25314: On 11th generation and 12th generation of PowerEdge servers running the Linux OS, the omreport system summary command displays **RAC Command Interface** as 7.1.0. "RAC Command Interface" is a DRAC4 RPM and its version is 7.1. It is installed as a dependent package for iDRAC6 and iDRAC7 Command Interface packages.

• JRT-22805: On Mozilla Firefox 21 or later, the Quit browser option does not work after logging out from Server Administrator. To close the browser or tab, you must manually close the Firefox browser tab.

• JRT-36610/JIT-36599: Restart the data manager service, after Intel NIC driver update or NVIDIA graphics driver update is performed.

• JRT-26671: On Server Administrator, the Duplex capability value is displayed as “Unknown” in Broadcom Extreme E-Series Network interface card in the NIC properties.

• JRT-60297: On RedHat Enterprise Linux 7.3, after performing ASR operation; restart the system once it recovers from ASR operation. Then navigate to Server Administrator Logs page in GUI. You could see an XML error. This could be due to xml log files being corrupted. To Recover: Perform clear logs operation so that new logs would be generated. Before performing this operation, if needed please take back up of old xml log files.

• JRT-69735: On Server Administrator web application blocks the client connections in the Internet browser settings with TLSv1.0 version and lesser.

• JRT-60691: In SCOM – Server Management Pack (MP) for monitoring Physical and Team network interfaces XML files are created due to the heavy usage of the Server Administrator CLI NIC command (omreport chassis nic -fmt xml).

• JRT-36610/JIT-36599: On OpenManage Server Administrator slots page, the Dell “HBA330 Adapter” PERC card will be enumerated as “12GB/s HBA internal” and Dell “HBA330 Mini” PERC card will be enumerated as “SAS3008 PCI-Express Fusion-MPT SAS-3.

• JRT-81661: On 14G PowerEdge servers, the embedded cache devices are incorrectly displayed as a Field Replaceable Unit (FRU). These embedded cache devices are not FRUs.
• JIT-83687: Srvadmin-install.sh --express install fails now trying to install Remote Enablement Installation of OpenManage System Administrator with express option may fail on Linux Operating system due to the selection of Remote Enablement( cimagent) component.
   Workaround: Use interactive mode of installation to avoid the selection of Remote Enablement( cimagent) component.

• JIT-82753: Though the Server Administrator web server preferences (General Setting->Server Preferences) configuration is updated, the preference settings does not get updated as the Web server restart operation is not successful when you click on "Restart Web server" link.
   Workaround: Restart "DSM SA Connection Service" through Windows service panel or using Server Administrator CLI command *omconfig system webserver action=restart

• JIT-82008: When you insert or remove, the Hot pluggable USB devices may not be inventoried by Server Administrator's inventory automatically.
   Workaround to resolve this issue : Restart Server Administrator Shared Service.

Issues for Remote Access

NOTE: The Remote Access Service is supported on 11th generation of PowerEdge servers only. The following subsections list the currently known issues regarding implementation and operation of your RAC and the Remote Access Service in Server Administrator.

Issues of Server Administrator on all Operating Systems

• The Server Administrator user interface and commands related to local authentication enable are not applicable for RAC firmware 3.20. The Active Directory authentication feature replaces the local operating system authentication feature in this version of firmware. Due to this change, the following commands return errors:
  – racadm localauthenable
  – omconfig rac authentication

NOTE: The following packages will be deprecated from DellEMC Server Administrator current release (9.1.0):
  a Srvadmin-racadm4.
  b Srvadmin-racadm5.

• Due to fluctuations in the watchdog timer, the Last Crash Screen may not be captured when the Automatic System Recovery is set to a value of less than 30 seconds. To ensure the correct functioning of the Last Crash Screen feature, set the System Reset Timer to at least 30 seconds.

• DF132894: The cfgDNSServer1 and cfgDNSServer2 properties of group cfgLanNetworking may be set to identical values while swapping addresses. Some performance may be lost temporarily during the swapping. The cfgLanNetworking group is configured using the racadm config command.

• The remote access controller uses FTP protocol to perform some of the Server Administrator commands. If a firewall is installed in the system, it may cause these commands to fail.

The following Server Administrator CLI commands use FTP protocol to communicate with the RAC:
  – omconfig rac uploadcert
  – omconfig rac generatecert

The following racadm commands use FTP protocol to communicate with the RAC:
  – racadm sslcertupload
  – racadm sslcsrgen
  – racadm fwupdate

• If the RAC configuration is reset to factory defaults using the racadm racresetcfg command, the RAC configuration tab in Server Administrator does not reflect the reset configuration settings until the system reboots. Also, the RAC configuration page in Server Administrator cannot be used to make any configuration changes until the system reboots.

• The RAC does not support local RAC user IDs with special characters. When adding a local RAC user, use only alphanumeric characters for the user name.
• While the RAC is being reset, the Instrumentation Service cannot read sensor data for certain systems. As a result, the voltage, temperature, and other probes may not be visible on the Server Administrator home page until the RAC has completed resetting.

• The RAC may not send traps when your system is locked up. To enable traps to be sent when the system is locked, configure the watchdog timer using the Server Administrator GUI. On the GUI, click the "Properties" tab and ensure that Auto Recovery is selected. The default value of the Action On Hung Operating System Detection setting is None None indicates that detection will not be performed.

• RAC firmware 2.0 and later does not support passwords with special characters (non-alphanumeric) only for RAC user IDs logging in using the Web-based interface (with Local RAC Authentication). You cannot log on to RAC, if you created RAC user IDs using previous versions of the firmware or using Server Administrator that is running version 2.0 firmware on the managed system.

Use one of these methods to correct this issue:

– Change your passwords before updating the firmware.
– Use the following CLI command to change the password: omconfig rac users username=xx userpassword=yy where xx is the original user ID and yy is the new password.
– Change the password through Server Administrator using the User tab. Make sure that the check box to change the password is checked. Enter a new password, and then enter it again to validate the change.
  ◦ Use the racadm utility to change the password: racadm config -g cfgUserAdmin -o cfgUserAdminPassword -i <usr_index> <new_pwd> where <usr_index> is the index of the user database entry to be modified and <new_pwd> is the new password.

• Depending on your network and proxy configurations and whether you are using Mozilla browser, you may need to enter the exact IP address of the RAC controller, you are trying to access in the No Proxy for field of your browser.

Perform the following steps:

a) Open your Mozilla browser.
b) Click Edit.
c) Click Preferences.
d) Click Advanced in the left sidebar.
e) Click Proxies in the left sidebar.
f) Enter the RAC IP address in the No Proxy for field.
g) Click OK and then close the browser.

• To view the RAC Web-based interface when using Mozilla 1.6, you must configure your cookie settings to Enable all cookies.
• To enable all cookies, go to the menu options and click Edit > Preferences > Privacy & Security > Cookies, and then select Enable all cookies. If you do not perform these steps, you cannot log on to the Web interface and a message appears indicating that your username and password are incorrect.

• DF384362: Redundancy Status displays as Not Applicable in ESXi even when NICs are teamed. On VMware ESXi systems, NIC teaming status may not display up in the Server Administrator network section. This is an expected behavior due to the operating system limitation and has no functional impact to the system.

• DF384061: Self-signed certificate does not enable the compatibility listener in Windows 2008 R2 managed node. On a Windows 2008 R2 managed node, a valid CA signed certificate is required to create compatibility mode WinRM Listener. You cannot create a compatibility mode listener with a self-signed certificate.

• DF380725: On Internet Explorer or Firefox Web browsers, you cannot attach files to an e-mail if the filename contains non-ASCII letters. To attach files to an e-mail, rename files to contain ASCII characters.

• On 12th generation of PowerEdge servers, Server Administrator displays the Embedded Systems Management (ESM) or hardware logs. However, when the maximum limit for number of logs that can be recorded is reached, the existing oldest logs are overwritten. But for 11th generation of PowerEdge servers or prior, when the maximum limit is reached, the information logging is stopped.

• DF523827: On Citrix XenServer 6.0 or later, if the Alert on Console alert action is configured from the Server Administrator CLI or GUI, the alert message may not be displayed in a readable format.

• BITS113585: Server Administrator does not log CPU or CMOS Battery Probe Alerts and does not send SNMP traps.

• To resolve this issue, stop the USB arbitration service and run the Inventory Collector. To stop the USB arbitration service:
  a) Run the ps auxgrep usb command to check if the USB arbitration service is running.
  b) Run the chkconfig usbarbitrator off command to prevent the USB arbitration service from starting during boot.
  c) After the USB arbitrator service is stopped, reboot the server to allow the Inventory collector to run.

• DF520449: On all versions of the ESX, the following USB connection error messages are generated. These messages can be ignored. The following is a typical message:
### Table 1. USB connection error message

<table>
<thead>
<tr>
<th>Vendor</th>
<th>Model</th>
<th>Rev</th>
</tr>
</thead>
<tbody>
<tr>
<td>iDRAC</td>
<td>MAS022</td>
<td>1.00</td>
</tr>
<tr>
<td>Type</td>
<td>Direct-Access</td>
<td>ANSI SCSI revision: 02</td>
</tr>
</tbody>
</table>

### Table 2. USB connection error message

<table>
<thead>
<tr>
<th>Vendor</th>
<th>Model</th>
<th>Rev</th>
</tr>
</thead>
<tbody>
<tr>
<td>iDRAC</td>
<td>SECUPD</td>
<td>0329</td>
</tr>
<tr>
<td>Type</td>
<td>Direct-Access</td>
<td>ANSI SCSI revision: 02</td>
</tr>
</tbody>
</table>

- **DF531509**: The setup and/or system password configuration from the Server Administrator GUI or CLI is successful, but the password is displayed as blank instead of asterisk (*) on the F2 BIOS page.
- **DF532055**: From Windows Server 2008 R2 SP1, when an administrator manages Red Hat Enterprise Linux 6.1 (64-bit) or 5.7 (32 and 64-bit) operating systems, Server Administrator reports connection error intermittently.

**Workaround**: Perform the following and manage the remote system from the web server.

1. Configure TCP Chimney offload to disable state by running the following command: `netsh int tcp set global chimney=disabled`
2. Configure RSS (Receive Side Scaling) to disable state by running the following command: `netsh int tcp set global rss=disabled`
3. Configure NetDMA to disable state by running the following command: `netsh int tcp set global NetDMA=disabled`

- **BITS086423**: After an upgrade to the current version, Server Administrator does not retain the support link information on the Preferences page.
- **BITS091830**: Distributed Web Server (DWS) connection does not work if you have installed the sblim-sfcb rpm from SLES11 SP3 operating system DVD. To make the connection work, install sblim-sfcb rpm either from SLES11 SP2 or from OM DVD.
- **BITS040184**: User in IDRAC user authentication page showing operator privilege (IDRAC user privileges) is displayed as Custom in Server Administrator.
- With the following wsman rpm versions getting carried in SLES12 OS, OMSA DWS does not work. Update these rpms having same or later versions from SUSE

- `openwsman-server-2.4.11-2.18.x86_64.rpm`
- `libwsman1-2.4.11-2.18.x86_64.rpm`
- `libwsman_clientpp1-2.4.11-2.18.x86_64.rpm`
Dell EMC OpenManage Release Notes
Version 9.1

The following section describes the issues and workaround in Server Administrator Storage Management.

Known Issues and Workarounds for Storage Management Service

- With Chinese or Japanese language browser settings, using the Storage Management Service Advanced Create Virtual Disk Wizard may occasionally result in text overflowing to the bottom of the side-by-side blue text boxes.
- View slot occupancy report shows 4 HDD slots on backplanes with just two HDD slots for any server.
- Physical disk clear operation is not available on PERC 8, PERC 9, and PERC 10 family of Hardware controllers.
- Physical disk properties such as Manufacture day, Manufacture week, and Manufacture year are available for SAS drives only.
- Creating many sliced span virtual disks using the spun-down drives through the command line or GUI result may be delayed.

Workaround: After creating one sliced span virtual disk, wait for some time to create the next sliced span virtual disk.
- For 14G servers, only two enclosures per controller is supported.
- A Security Key Identifier can contain numerals, lowercase alphabets, uppercase alphabets, nonalphanumeric characters (except space), or a combination of any of these.

**NOTE:** If you have used the special characters "/" (forward slash) or "'" (single quote) in the Security Key Identifier, they are displayed as "_" (underscore) on the Change Security Key page and Import Secured Foreign Configurations page. This is applicable only to the Security Key Identifier and not to the Passphrase.

- If Storage Management displays a path failure message for a Logical Connector after a reboot, use the Clear Redundant Path View, provided in the Change Controller Properties controller task, and restart the system.

**NOTE:** Use this command only if you have intentionally removed the multipath connection while rebooting the system.

- In the VMware ESXi 6.x environment, when you create a virtual disk using Storage Management, you may see an error message "The task failed to complete: The create virtual disk task was successful but the operating system may not be aware of the new virtual disk." However, the virtual disk is available for all operations on rebooting the system.
- Patrol Read is not supported on SSD media. The Patrol Read feature fails for any controller that has SSD media on a virtual disk.
- Hot plug of enclosures takes time to enumerate the enclosure and its components. During this time, there will be a delay in the response time of tasks, such as displaying the physical disks on the physical disk page and in the virtual disk selection page.
- All virtual disks from the SAS/IR controller display the name IR Virtual Disk on the Preview page. On successful import, another name is assigned to these virtual disks and the "IR Virtual Disk" name is not displayed on the "Preview" page.
- Storage Management does not permit connecting the first enclosure in single path and attaching the subsequent enclosures in multipath. All enclosures must be connected in multipath to enable the multipath view.
- An error message may not appear when Import Foreign Configuration task is not successful.

**Description:** The Import Foreign Configuration task can only import virtual disks that have consistent data. A virtual disk with inconsistent data cannot be imported. When importing multiple virtual disks in a single operation, however, the Import Foreign
Configuration task may report successful completion even when inconsistent virtual disks are present and have not been imported successfully.

Solution: If the "Import Foreign Configuration" task is unable to import an inconsistent virtual disk, then the physical disks that belong to the virtual disk continue to display a "Foreign" state after the "Import Foreign Configuration" task completes. In this case, repeat the "Import Foreign Configuration" task until one of the following occurs:

- There are no longer any physical disks in Foreign state after the Import Foreign Configuration task completes.
- You receive an error stating that the Import Foreign Configuration task has not completed successfully. This error indicates that there are no longer any consistent virtual disks available to be imported. Therefore, all virtual disks that are not imported are inconsistent and you can either perform a "Clear Foreign Configuration" to remove the virtual disks or remove the physical disks from the controller.

  • DF60696: Storage Management responds slowly when using Internet Explorer 9.x or 10.x on a system with mixed SAS and SATA physical disks.

  Description: When using the "Create Virtual Disk" wizard from the Storage Management graphical user interface (GUI), you may notice decreased performance when using Internet Explorer 9.x or 10.x on a system with multiple physical disks. The MD1000/MD1400/MD1420 storage enclosures that are heavily populated with mixed SAS and SATA physical disks.

  Solution: Use a supported web browser other than Internet Explorer 9.x or 10.x or use the Storage Management command line interface (CLI) to create the virtual disk. See the Dell EMC OpenManage Server Administrator Release Notes for information on supported browsers. See the Storage Management online Help or the "Server Administrator Command Line Interface User's Guide" for information on using the Storage Management CLI.

  • DF152362: Storage Management may not display controllers installed with the Service and Diagnostics utility.

  • Description: Storage Management may not recognize devices that are installed after Storage Management is already running.

  Solution: If Storage Management does not recognize a newly-added device and this problem has not been corrected with a Global Rescan, then reboot the system.

  • DF120475: Storage Management SNMP traps are not filtered by Server Administrator.

  • Description: Server Administrator allows you to filter SNMP traps that you do not want to receive. To implement SNMP trap filtering, select the System tree > Alert Management tab > SNMP Traps subtab. The SNMP Traps subtab has options for enabling and disabling SNMP traps based on severity or the component that generates the trap. Even when the SNMP traps are disabled, Storage Management generates SNMP traps.

  Solution: SNMP trap filtering will be provided in a future release of Storage Management.

  • When issuing certain omconfig storage CLI commands with Power User privileges, the Error! User has insufficient privileges to run command: omconfig message may be displayed. You must be logged on as an Administrator to perform these actions.

  • Using the Storage Management Service Advanced Create Virtual Disk Wizard may occasionally result in a vertical scrollbar of less than normal width. If this occurs, resizing the Server Administrator window causes the vertical scrollbar to be redrawn correctly.

  • Using the GUI, if a virtual disk is renamed to a name containing multiple blank and consecutive spaces, the name is truncated to a single space after Apply is clicked.

  • BITS118226: The representation of NVMe devices residing on backplanes that attach to PCIe Extender cards is inaccurate on Storage Management. This is because Storage Management does not have a process to understand the mapping of the NVMe device, backplane, and the PCIe Extender card. This issue exists only on PowerEdge R920 servers and does not impact the operations on the NVMe device. Multiple backplanes on Server Administrator indicate the presence of multiple PCIe Extender cards on the system.

  • BITS124349: Firmware version for SAS 9207_8e, SAS 9206_16e, and SAS 9300_8e, will not be displayed on the Storage Management GUI and CLI.

  • BITS123999: SAS 9300_8e is not supported on systems running the VMware ESXi operating system.
• **BITS128355**: The slot occupancy report displays single backplane ID and backplane name in the Storage Management GUI and CLI. The physical disk slot occupancy report for PCIe Subsystem displays NVMe devices present in two different PCIe backplanes under the same PCIe backplane on PowerEdge R920 servers. The NVMe devices connected to different PCIe backplanes are displayed correctly under **Storage > PCIe-SSD Subsystem > PCIe-SSD Extender > Enclosure**.

• **BITS146054**: The enclosure automatically sets the critical and default warning thresholds. The user cannot set or reset any warning threshold to any temperature probe through the Storage Management GUI or CLI.

• On a PowerEdge server with maximum configuration of 8 populated enclosures connected to the PERC hardware controller, the user can experience a delay in response. When Server Administrator storage commands such as Create Virtual Disk or Start check consistency are run, the delay in response can range from 10 — 30 minutes.

• **BITS148893**: When creating a virtual disk on PERC S130 (software RAID) controller, if you do not select the first option under **Assign Dedicated Hot Spare** a message appears: **DHS not assigned to VD**. When you create a virtual disk on a software RAID controller using the **Create Virtual Disk** wizard, the GUI control only verifies the first available option under DHS, leaving the other options unverified even if it is selected.

Resolution: The Dedicated Hot Spare assignment can be performed through the following.

**System > Storage > Controller > Virtual Disk** under the respective virtual disk Tasks drop-down list, select Tasks **Assign/Unassign Dedicated Hot Spare**.

• **BITS161852**: The limitation is observed when two enclosures are connected to two ports of PERC H830 controller. The limitation is not observed when the enclosures are connected in a daisy-chain configuration. In the **Create Virtual Disk Advanced Wizard** screen, enclosures and physical disks are listed together. The user must select only the physical disks and not the enclosures when creating a virtual disk using the **Advanced Wizard** option.

• **BITS140465**: When the user tries to create another partial virtual disk of any RAID level, on an existing, but degraded disk group, Storage Management does not allow the user to perform this action. This limitation occurs because Storage Management does not support this functionality. However, this limitation is only observed on certain PERC 9 family of hardware controllers (PERC H330, H830, and H730).

Workaround: The user can create a partial virtual disk during system restart using the CTRL+R configuration utility.

• **JIT-10452 (BITS236815)**: Occasionally, the virtual disk creation process on PERC 9 hardware controllers may fail on GUI and CLI. Workaround: Restart the server to resolve this issue.

• **BITS055347**: On systems running the ESXi 5.1 or later operating system, the “Device Name” for all virtual disks will be displayed as a blank. This is an expected behavior on systems running the ESXi 5.1 or later operating system.

• **JIT-8321 (BITS220411)**: Unable to create Partial Secure virtual disk using the GUI when all the available SEDs are selected. This operation will work if any other physical disk, which is not a part of any virtual disk, is connected.

• **JIT-11205 (BITS242664)**: When a physical disk, which is a part of multiple partial virtual disks, is reinserted into the system, the status of the partial virtual disks will be displayed on Storage Management after a short delay.

• **JIT-8442 (BITS221272)**: Few enclosure alerts such as Enclosure power on/off and Fan removal, does not appear if the enclosure is connected to the server using a SAS 12 Gbps HBA card. Restart Data Manager Service to update component status.

• **JIT-15099 (BITS262349)**: NVMe Slot Occupancy Report for PCIe SSD displays inaccurate PCIe SSD slot count. The report displays four PCIe SSD slots instead of two PCIe SSD slots. This issue is applicable for the Server having less than 4 NVMe slot count, like M/FC630, M/FC830, M620 and M820 blades.

• **JIT-10933 (BITS240247)**: Storage Management does not display the Device name on a system where there more than 300 virtual disks.

• **JIT-15612 (BITS264534)**: If a server has only software RAID S130 controller (no PERC controllers) and the operating system is booted through the same controller, the user will not be able to set the Remaining Rated Write Endurance threshold using the Server Administrator GUI.

• **JIT-72304**: Able to assign lesser capacity physical disk as a DHS to the virtual disk created with physical disk having higher capacity.
**JIT-16919 (BITS270856):** On Precision 7910 running a client operating system (for example, Windows 8.1 x64), the PERC 9.3 driver version is displayed as outdated and a yellow bang is shown on such hardware configurations. This issue does not cause any functionality limitation.

**JIT-43557:** In Split Mode, Slot occupancy report displays inaccurate empty slots when there are no drives connected to the backplane. The report shows the message empty slots interchanged between controller. This issue occurs for the server with no drives attached to the backplane in split mode only. Slot occupancy report works fine as expected for servers with a minimum of one drive.

**JIT-52091:** Cryptographic erase operation might take longer time to be visible in the dropdown list for the ISE Capable SATA SSDs after this operation is done.

**JIT-58147:** In the BOSS-S1 controller properties, slot ID is displayed as "Embedded".

If the background IO is in progress, "Prepare to Remove" operation for the NVME devices might fail.

From 14G onwards, no Channel/Connector information will be displayed under "PCIe SSD Subsystem". Enclosure/Backplane will be directly connected to the "PCIe SSD Subsystem". There is no change in the display of "NVMe Devices ( Arraydisk ) and Add-On Card ( HHHL Card )". NVMe Devices ( Arraydisk ) will be displayed under "Enclosure / Backplane" whereas Add-On Card ( HHHL Card ) will be displayed under "PCIe SSD Subsystem".

**JIT-60971:** In OMSA, the empty slots in slot-occupancy report is not displayed after "prepare to remove" operation is performed on the servers with one or more PCIe Backplane.

**JIT-61216:** Unable to create virtual disks (Raid 0, 1, 5) using Advanced Wizard if NVME add in card is present.

Description: In PERC S140 advanced wizard, virtual disk creation fails if a combination of NVMe and HHHL addin cards(AIC) are present.

This issue is observed if the PCI slot ID of the add-in card (AIC) matches with the NVMe drive slot number. However, if only NVMe drives are used, you can successfully create the virtual disks. This is because the GUI code is unable to differentiate the slot ID/number in Create Virtual Disks Advanced Wizard.

*NOTE:* This issue does not cause any data loss. The RAID-5 on S140 with NVMe drives is not supported.

Solution: To resolve this issue, you can create a virtual disk using the Create Virtual Disks Express Wizard and OM-CLI.

**JIT-63561:** In Dell’s 14th generation of PowerEdge servers, while doing the "Reconfiguration" operation, "Auto Configure RAID0" option is listed in OMSA under H730P controller’s "Available tasks". It happens during RAID level migration from RAID1 to RAID0.

**JIT-71918:** On 14 generation of PowerEdge servers when connected with two SAS 12Gbps controllers in Slot4 & Slot5 and each controllers are connected with separate MD1400 enclosure, both Enclosure EMMs are listed under "Connector 0" and no device is listed under “Connector 1”. Slot-4 SAS 12Gbps controller is connected with two redundant EMMs which are listed in "Connector 0". Slot-5 12Gbps controller is also connected with two redundant EMMs, but both are listed under "Connector 0".

**JIT-71919:** On 14 generation of PowerEdge servers when connected with two SAS 12Gbps controller in Slot4 & Slot5 and each controllers are connected with separate MD1400 enclosure, with two redundant cable i.e. EMM0 & EMM1, then with redundant EMM both enclosures are listed for EMM0 & EMM1, but physical disks are not displayed for EMM1. Slot-4 SAS 12Gbps controller is connected with two redundant EMMs – Here both EMMs are listed under “Connector 0”, and for EMM0 physical Disk is listed and for EMM1 no physical disks are listed. Slot-5 SAS 12Gbps controller is connected with single EMM (ie.EMM1) – Here one EMM0 is listed under “Connector 0”, and for EMM1 physical Disk are listed.

**JIT-78857:** Successful Prepare to remove and reinsertion operation on a drive for 3-4 times, will result in all the drives getting removed and inserted back in ESXi 6.5 U1 operating system.

**JIT-79925:** On 13th generation of PowerEdge servers, OMSS reports for PCIe Link Speed is negotiated and maximum link speed/width shows '0' for Slot 1 device.

**JIT-76259:** EMM alert description for Dedicated hot spare assigned physical disk should contain meaningful alert description instead of the statement, This alert is provided for informational purposes.

**JIT-72304:** Able to assign lesser capacity physical disk as a DHS to the virtual disk created with physical disk having higher capacity.

**JIT-80079:** If Prepare to remove operation is executed on a Non-RAID PCIe-SSD physical disk, the bus protocol for the virtual disk associated with that physical disk, changes to SATA from PCIe-SSD.
- **JIT-84544**: In every refresh cycle for NVMe drives in VMware (ESXi) OS, following warning message is displayed in the vmkernel.log.
  
  `LinuxThread: 381: sfcb-dcim: Error cloning thread: -1 (bad0117)`

- **JIT-98301**: The storage tree on the OM page disappears when there is I/O stress on ESXi host for multiple days. Workaround: Restart the service manually.

- **JIT-90125**: On Server Administrator while configuring the enclosure asset tag and name with maximum length, Server Administrator displays all the characters completely. But in iDRAC GUI, enclosure asset tag displays the last character as truncated.

### Installation Prerequisites

Storage Management does not display controllers and their features on systems that do not meet the driver and firmware requirements. At Storage Management runtime, you can determine whether the system meets the firmware requirement or not, by checking the application log files for notifications on outdated firmware. At runtime, On SCSI controllers, Storage Management displays the firmware version at runtime while on SAS controllers it displays the firmware and driver versions.

### Installation Procedure

For complete installation instructions, see the **Dell EMC OpenManage Server Administrator version Installation Guide**.

This section provides information to enhance your experience with Server Administrator implementations and environments.

- To install Server Administrator on Windows Server 2008 R2 SP1 Core and Windows Server 2012 Core, Windows-on-Windows (WOW) mode must be enabled.

- Port 1311 is the default port for Server Administrator. It is a registered port number of Server Administrator. If another application is configured to run on port 1311 before Server Administrator is installed, the DSM SA Connection Service does not start after installation. Before you install Server Administrator, make sure that the port 1311 is not in use.

- Before starting Server Administrator, you must enable the client-side scripting in Internet Explorer.

To do so, perform the following:

a. In Internet Explorer, navigate to the **Tools** menu.

b. Click **Internet Options**.

c. Click the **Security** tab.

d. Select the security zone to which the system running Server Administrator belongs.

![NOTE: This option should be set to Trusted sites.](image)

- Click the **Custom Level** button.

- For Windows 2003, perform the following:
  1. In **Miscellaneous**, select the **Allow META REFRESH** radio button.
  2. In **Active Scripting**, select the **Enable** radio button.
  3. Under **Active scripting**, select the **Allow scripting of Microsoft web browser controls** radio button.

g. Click **OK** and restart your browser.

- To allow Single Sign-on for Server Administrator, perform the following steps:
  a. In Internet Explorer, navigate to **Tools**.
  b. Click **Internet Options**.
  c. Click the **Security** tab.
  d. Select **Trusted sites**.
  e. Click the **Custom Level** button.
Under **User Authentication**, select the **Automatic Logon with current username and password** radio button. Click **OK** to exit the **Custom Level** window.

Select the **Advanced** tab and in **HTTP 1.1 settings**, make sure **Use HTTP 1.1** is checked.

Select **Trusted sites**. Click **Sites**. Add the server to the website.

Click **Close**.

Click **OK** and restart your browser.

If you run a security scanner tool such as Nessus, against the Server Administrator Web server, security warnings may be displayed against port 1311, the port running the Server Administrator Web server. The warnings have been investigated by engineering and are determined to be "false positives" (invalid security warnings) that you can ignore. The following are the warnings:

- The Web server on 1311 allows scripts to read the sensitive configuration and/or XML files.
- The Web server on 1311 allows to delete "/" which implies that the web server will allow a remote user to delete the files in root on the server.*
- The web server on 1311 may be susceptible to a 'www Infinite Request' attack.

It is possible to make the remote thttpd server execute arbitrary code by sending a request like: GET If-Modified-Since:AAA[...]AAAA

Solution: If you are using thttpd, upgrade to version 2.0. Else, contact the vendor for a patch or change the web server. CVE on this one is CAN-2000-0359*.

Enabling Integrated Windows Authentication in Internet Explorer is not required to activate the Single Sign-On feature.

The Server Administrator security settings are not applicable for Active Directory users. Active Directory users with read-only login can access Server Administrator, even if the access is blocked in the Server Administrator Preferences page.

Dell SNMP MIB Files for Dell Systems:

Dell SNMP MIB files for Dell systems allow you to obtain and verify information provided by supported software agents. The current MIB files supported by PowerEdge software agents are located at `\support\mib` on the Systems Management Tools and Documentation DVD.

**NOTE:**

A MIB-II-compliant, SNMP-supported network management station is required to compile and browse MIB files.

OpenManage support for Encrypting File System (EFS)

To improve security, Microsoft allows encrypting files using EFS. Note that SERVER ADMINISTRATOR will not function if its dependent files are encrypted.

Server Administrator GUI and CLI Response Time

On PowerEdge 10th generation of PowerEdge servers or later, the response time for some components of the Server Administrator GUI and CLI has increased to several seconds as Server Administrator does not cache some of the DRAC/iDRAC data. The data is retrieved from the DRAC/iDRAC when you request for it.

Following are the Server Administrator GUI pages for which the response time may have increased:

- Server Administrator home page on log in
- Remote Access > Users
- Alert Management > Platform Events

Following are the Server Administrator CLI commands for which the response time may have increased:

- `omreport chassis remoteaccess config=user`
- `omreport system platformevents`
- `omreport system pedestinations`

The amount of time varies depending on the hardware and operating system.
Firmware for PERC controllers


Table 3. Firmware for PERC controllers

<table>
<thead>
<tr>
<th>Controller</th>
<th>Firmware/BIOS</th>
</tr>
</thead>
<tbody>
<tr>
<td>PERC 6/E Adapter</td>
<td>6.3.3-0002</td>
</tr>
<tr>
<td>PERC 6/i Integrated</td>
<td>6.3.3-0002</td>
</tr>
<tr>
<td>PERC 6/i Adapter</td>
<td>6.3.3-0002</td>
</tr>
<tr>
<td>SAS 6/iR Integrated</td>
<td>00.25.47.00 06.22.03.00</td>
</tr>
<tr>
<td>SAS 6/iR Adapter</td>
<td>00.25.47.00 06.22.03.00</td>
</tr>
<tr>
<td>SAS 6/int. Modular</td>
<td>00.25.47.00 06.22.03.00</td>
</tr>
<tr>
<td>PERC H800 Adapter</td>
<td>12.10.7-0001</td>
</tr>
<tr>
<td>PERC H700 Integrated</td>
<td>12.10.7-0001</td>
</tr>
<tr>
<td>PERC H700 Adapter</td>
<td>12.10.7-0001</td>
</tr>
<tr>
<td>PERC H700 Modular</td>
<td>12.10.6-0001</td>
</tr>
<tr>
<td>PERC H200 Adapter</td>
<td>07.03.06.00</td>
</tr>
<tr>
<td>PERC H200 Integrated</td>
<td>07.03.06.00</td>
</tr>
<tr>
<td>PERC H200 Modular</td>
<td>07.03.06.00</td>
</tr>
<tr>
<td>PERC H200 Embedded</td>
<td>07.03.06.00</td>
</tr>
<tr>
<td>6Gbps SAS HBA</td>
<td>07.03.06.00</td>
</tr>
<tr>
<td>Internal Tape Adapter</td>
<td>07.03.06.00</td>
</tr>
<tr>
<td>PERC H310 Adapter</td>
<td>20.13.2-0004</td>
</tr>
<tr>
<td>Controller</td>
<td>Firmware/BIOS</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>PERC H310 Mini Monolithic</td>
<td>20.13.2-0004</td>
</tr>
<tr>
<td>PERC H310 Mini Blades</td>
<td>20.13.2-0004</td>
</tr>
<tr>
<td>PERC H710 Adapter</td>
<td>21.3.2-0005</td>
</tr>
<tr>
<td>PERC H710 Mini Blades</td>
<td>21.3.2-0005</td>
</tr>
<tr>
<td>PERC H710 Mini Monolithic</td>
<td>21.3.2-0005</td>
</tr>
<tr>
<td>PERC H710P Adapter</td>
<td>21.3.2-0005</td>
</tr>
<tr>
<td>PERC H710P Mini Blades</td>
<td>21.3.2-0005</td>
</tr>
<tr>
<td>PERC H710P Mini Monolithic</td>
<td>21.3.2-0005</td>
</tr>
<tr>
<td>PERC H810 Adapter</td>
<td>21.3.2-0005</td>
</tr>
<tr>
<td>PERC S110</td>
<td>3.0.0.0139</td>
</tr>
<tr>
<td>PERC S100</td>
<td>2.0.0-0162</td>
</tr>
<tr>
<td>PERC S130</td>
<td>4.1.0-0006</td>
</tr>
<tr>
<td>PERC S300</td>
<td>2.0.0-0166+00193000</td>
</tr>
<tr>
<td>PERC H730P Adapter</td>
<td>25.4.0.0017</td>
</tr>
<tr>
<td>PERC H730P Mini Blades</td>
<td>25.4.0.0017</td>
</tr>
<tr>
<td>PERC H730P Mini</td>
<td>25.4.0.0017</td>
</tr>
<tr>
<td>PERC H730P Slim</td>
<td>25.4.0.0017</td>
</tr>
<tr>
<td>PERC H730 Adapter</td>
<td>25.4.0.0017</td>
</tr>
<tr>
<td>PERC H730 Mini 25.2.1.0011 Blades</td>
<td>25.4.0.0017</td>
</tr>
<tr>
<td>PERC H730 Mini</td>
<td>25.4.0.0017</td>
</tr>
<tr>
<td>PERC H830 Adapter</td>
<td>25.4.0.0017</td>
</tr>
<tr>
<td>PERC H330 Adapter</td>
<td>25.4.0.0017</td>
</tr>
<tr>
<td>PERC H330 Mini</td>
<td>25.4.0.0017</td>
</tr>
<tr>
<td>PERC H330 Mini Blades</td>
<td>25.4.0.0017</td>
</tr>
<tr>
<td>PERC H330 Embedded</td>
<td>25.4.0.0017</td>
</tr>
<tr>
<td>HBA 330 Adapter</td>
<td>09.17.20.07</td>
</tr>
</tbody>
</table>
### Table 4. Firmware for BOSS-S1 controller

<table>
<thead>
<tr>
<th>Controller</th>
<th>Firmware/BIOS</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOSS-S1</td>
<td>2.3.13.1083</td>
</tr>
</tbody>
</table>

### Microsoft Windows Drivers for PERC Controllers


### Table 5. Microsoft Windows drivers for PERC controllers

<table>
<thead>
<tr>
<th>Controller</th>
<th>Windows Server 2012 Driver</th>
<th>Windows Server 2012 R2 Driver</th>
<th>Windows Server 2016 Driver</th>
</tr>
</thead>
<tbody>
<tr>
<td>PERC 6/E Adapter</td>
<td>2.24.0.32</td>
<td>2.24.0.64</td>
<td>Native</td>
</tr>
<tr>
<td>PERC 6/i Integrated</td>
<td>2.24.0.32</td>
<td>2.24.0.64</td>
<td>Native</td>
</tr>
<tr>
<td>PERC 6/i Adapter</td>
<td>2.24.0.32</td>
<td>2.24.0.64</td>
<td>Native</td>
</tr>
<tr>
<td>SAS 6/iR Integrated</td>
<td>1.28.03.01</td>
<td>1.28.03.01</td>
<td>Native</td>
</tr>
<tr>
<td>SAS 6/iR Adapter</td>
<td>1.28.03.01</td>
<td>1.28.03.01</td>
<td>Native</td>
</tr>
<tr>
<td>SAS 6/iR Modular</td>
<td>1.28.03.01</td>
<td>1.28.03.01</td>
<td>Native</td>
</tr>
<tr>
<td>LSI 1020 on a PowerEdge 1600SC</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>LSI 1030 on a PowerEdge 1750</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>PERC H800 Adapter</td>
<td>4.31.1.32</td>
<td>4.31.1.64</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H700 Integrated</td>
<td>4.31.1.32</td>
<td>4.31.1.64</td>
<td>Native</td>
</tr>
<tr>
<td>Controller</td>
<td>Windows Server 2012 Driver</td>
<td>Windows Server 2012 R2 Driver</td>
<td>Windows Server 2016 Driver</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------</td>
<td>-------------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>PERC H700 Adapter</td>
<td>4.31.1.32</td>
<td>4.31.1.64</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H700 Modular</td>
<td>4.31.1.32</td>
<td>4.31.1.64</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H200 Adapter</td>
<td>2.0.35.10</td>
<td>2.0.35.10</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H200 Integrated</td>
<td>2.0.35.10</td>
<td>2.0.35.10</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H200 Modular</td>
<td>2.0.35.10</td>
<td>2.0.35.10</td>
<td>Native</td>
</tr>
<tr>
<td>6Gbps SAS HBA</td>
<td>2.0.35.10</td>
<td>2.0.35.10</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H310 Adapter</td>
<td>6.803.21.00</td>
<td>6.803.21.00</td>
<td>6.805.01.00</td>
</tr>
<tr>
<td>PERC H310 Mini Monolithic</td>
<td>6.803.21.00</td>
<td>6.803.21.00</td>
<td>6.805.01.00</td>
</tr>
<tr>
<td>PERC H310 Mini Blades</td>
<td>6.803.21.00</td>
<td>6.803.21.00</td>
<td>6.805.01.00</td>
</tr>
<tr>
<td>PERC H710 Adapter</td>
<td>6.803.21.00</td>
<td>6.803.21.00</td>
<td>6.805.01.00</td>
</tr>
<tr>
<td>PERC H710 Mini Blades</td>
<td>6.803.21.00</td>
<td>6.803.21.00</td>
<td>6.805.01.00</td>
</tr>
<tr>
<td>PERC H710 Mini Monolithic</td>
<td>6.803.21.00</td>
<td>6.803.21.00</td>
<td>6.805.01.00</td>
</tr>
<tr>
<td>PERC H710P Adapter</td>
<td>6.803.21.00</td>
<td>6.803.21.00</td>
<td>6.805.01.00</td>
</tr>
<tr>
<td>PERC H710P Mini Blades</td>
<td>6.803.21.00</td>
<td>6.803.21.00</td>
<td>6.805.01.00</td>
</tr>
<tr>
<td>PERC H710P Mini Monolithic</td>
<td>6.803.21.00</td>
<td>6.803.21.00</td>
<td>6.805.01.00</td>
</tr>
<tr>
<td>PERC H810 Adapter</td>
<td>6.803.21.00</td>
<td>6.803.21.00</td>
<td>6.805.01.00</td>
</tr>
<tr>
<td>Internal Tape Adapter</td>
<td>2.0.35.10</td>
<td>2.0.35.10</td>
<td>Native</td>
</tr>
<tr>
<td>PERC S100</td>
<td>2.0.0-0162</td>
<td>2.0.0-0162</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>PERC S300</td>
<td>2.0.0-0162</td>
<td>2.0.0-0162</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>PERC S110</td>
<td>3.0.0.0134</td>
<td>3.0.0.0134</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>PERC S130</td>
<td>4.2.0-0009</td>
<td>4.2.0-0009</td>
<td>4.2.0-0009</td>
</tr>
<tr>
<td>PERC H730P Adapter</td>
<td>6.600.55.00</td>
<td>6.600.55.00</td>
<td>6.603.07.00</td>
</tr>
<tr>
<td>PERC H730P Mini Blades</td>
<td>6.600.55.00</td>
<td>6.600.55.00</td>
<td>6.603.07.00</td>
</tr>
<tr>
<td>PERC H730P Mini Monolithic</td>
<td>6.600.55.00</td>
<td>6.600.55.00</td>
<td>6.603.07.00</td>
</tr>
</tbody>
</table>
### Table 6. Windows Drivers for BOSS-S1 Controller

<table>
<thead>
<tr>
<th>Controller</th>
<th>Windows Server 2012 Driver</th>
<th>Windows Server 2012 R2 Driver</th>
<th>Windows Server 2016 Driver</th>
</tr>
</thead>
<tbody>
<tr>
<td>PERC H730P Slim</td>
<td>6.600.55.00</td>
<td>6.600.55.00</td>
<td>6.603.07.00</td>
</tr>
<tr>
<td>PERC H730 Adapter</td>
<td>6.600.55.00</td>
<td>6.600.55.00</td>
<td>6.603.07.00</td>
</tr>
<tr>
<td>PERC H730 Mini Blades</td>
<td>6.600.55.00</td>
<td>6.600.55.00</td>
<td>6.603.07.00</td>
</tr>
<tr>
<td>PERC H730 Mini Monolithic</td>
<td>6.600.55.00</td>
<td>6.600.55.00</td>
<td>6.603.07.00</td>
</tr>
<tr>
<td>PERC H830 Adapter</td>
<td>6.600.55.00</td>
<td>6.600.55.00</td>
<td>6.603.07.00</td>
</tr>
<tr>
<td>PERC H330 Adapter</td>
<td>6.600.55.00</td>
<td>6.600.55.00</td>
<td>6.603.07.00</td>
</tr>
<tr>
<td>PERC H330 Mini</td>
<td>6.600.55.00</td>
<td>6.600.55.00</td>
<td>6.603.07.00</td>
</tr>
<tr>
<td>PERC H330 Mini Blades</td>
<td>6.600.55.00</td>
<td>6.600.55.00</td>
<td>6.603.07.00</td>
</tr>
<tr>
<td>PERC H330 Embedded</td>
<td>6.600.55.00</td>
<td>6.600.55.00</td>
<td>6.603.07.00</td>
</tr>
<tr>
<td>FD33XD- PERC Dual</td>
<td>6.600.55.00</td>
<td>6.600.55.00</td>
<td>6.603.07.00</td>
</tr>
<tr>
<td>FD33XS PERC Single</td>
<td>6.600.55.00</td>
<td>6.600.55.00</td>
<td>6.603.07.00</td>
</tr>
<tr>
<td>12Gbps SAS HBA</td>
<td>2.50.92.00</td>
<td>2.50.92.00</td>
<td>2.51.1.2</td>
</tr>
<tr>
<td>HBA 330 Adapter</td>
<td>2.50.92.00</td>
<td>2.50.92.00</td>
<td>2.51.1.2</td>
</tr>
<tr>
<td>HBA 330 Mini</td>
<td>2.50.92.00</td>
<td>2.50.92.00</td>
<td>2.51.1.2</td>
</tr>
</tbody>
</table>

#### Linux Drivers for PERC Controllers

<table>
<thead>
<tr>
<th>Controller</th>
<th>Red Hat Linux 6.9 Driver</th>
<th>Red Hat Linux 7.4 Driver</th>
<th>VMware vSphere 6.5 U1 Driver</th>
<th>VMware vSphere 6.0 U3 Driver</th>
<th>SUSE Linux 11 SP4</th>
<th>SUSE Linux 12 SP3</th>
<th>UBUNTU 16.04.3</th>
</tr>
</thead>
<tbody>
<tr>
<td>PERC 6/E Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td>Native</td>
<td>Native</td>
<td>Not Supported</td>
</tr>
<tr>
<td>PERC 6/i Integrated</td>
<td>Native</td>
<td>Native</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td>Native</td>
<td>Native</td>
<td>Not Supported</td>
</tr>
<tr>
<td>PERC 6/i Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td>Native</td>
<td>Native</td>
<td>Not Supported</td>
</tr>
<tr>
<td>SAS 6/iR Integrated</td>
<td>Native</td>
<td>Native</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td>Native</td>
<td>Native</td>
<td>Not Supported</td>
</tr>
<tr>
<td>SAS 6/iR Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td>Native</td>
<td>Native</td>
<td>Not Supported</td>
</tr>
<tr>
<td>SAS 6/int. Modular</td>
<td>Native</td>
<td>Native</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td>Native</td>
<td>Native</td>
<td>Not Supported</td>
</tr>
<tr>
<td>LSI 1020 on 1600SC</td>
<td>Native</td>
<td>Native</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td>Native</td>
<td>Native</td>
<td>Not Supported</td>
</tr>
<tr>
<td>LSI 1030 on Power Edge 1750</td>
<td>Native</td>
<td>Native</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td>Native</td>
<td>Native</td>
<td>Not Supported</td>
</tr>
<tr>
<td>PERC H800 Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td>Native</td>
<td>Native</td>
<td>Not Supported</td>
</tr>
<tr>
<td>PERC H700 Integrated</td>
<td>Native</td>
<td>Native</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td>Native</td>
<td>Native</td>
<td>Not Supported</td>
</tr>
<tr>
<td>PERC H700 Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td>Native</td>
<td>Native</td>
<td>Not Supported</td>
</tr>
<tr>
<td>PERC H700 Modular</td>
<td>Native</td>
<td>Native</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td>Native</td>
<td>Native</td>
<td>Not Supported</td>
</tr>
<tr>
<td>PERC H200 Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td>Native</td>
<td>Native</td>
<td>Not Supported</td>
</tr>
<tr>
<td>PERC H200</td>
<td>Native</td>
<td>Native</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td>Native</td>
<td>Native</td>
<td>Not Supported</td>
</tr>
<tr>
<td>Controller</td>
<td>Red Hat Linux 6.9 Driver</td>
<td>Red Hat Linux 7.4 Driver</td>
<td>VMware vSphere 6.5 U1 Driver</td>
<td>VMware vSphere 6.0 U3 Driver</td>
<td>SUSE Linux 11 SP4</td>
<td>SUSE Linux 12 SP3</td>
<td>UBUNTU 16.04.3</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------</td>
<td>--------------------------</td>
<td>-------------------------------</td>
<td>-------------------------------</td>
<td>-------------------</td>
<td>-------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Integrated</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PERC H200 Modular</td>
<td>Native</td>
<td>Native</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td>Native</td>
<td>Native</td>
<td>Not Supported</td>
</tr>
<tr>
<td>6Gbps SAS HBA</td>
<td>Native</td>
<td>Native</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td>Native</td>
<td>Native</td>
<td>Not Supported</td>
</tr>
<tr>
<td>PERC H310 Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Not Supported</td>
</tr>
<tr>
<td>PERC H310 Mini Monolithic</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Not Supported</td>
</tr>
<tr>
<td>PERC H310 Mini Blades</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H710 Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H710 Mini Blades</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H710 Mini Monolithic</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H710P Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H710P Mini Blades</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H710P Mini Monolithic</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H810 Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td>Internal Tape Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Not Supported</td>
</tr>
<tr>
<td>Controller</td>
<td>Red Hat Linux 6.9 Driver</td>
<td>Red Hat Linux 7.4 Driver</td>
<td>VMware vSphere 6.5 U1 Driver</td>
<td>VMware vSphere 6.0 U3 Driver</td>
<td>SUSE Linux 11 SP4</td>
<td>SUSE Linux 12 SP3</td>
<td>UBUNTU 16.04.3</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------------------</td>
<td>--------------------------</td>
<td>-------------------------------</td>
<td>-------------------------------</td>
<td>-------------------</td>
<td>-------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>PERC S100</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
</tr>
<tr>
<td>PERC S300</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
</tr>
<tr>
<td>PERC S110</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
</tr>
<tr>
<td>PERC S130</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
</tr>
<tr>
<td>PERC H730P Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H730P Mini Blades</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H730P Mini Monolithic</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H730P Slim</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H730 Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H730 Mini Blades</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H730 Mini Monolithic</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H830 Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H330 Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H330 Mini Blades</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H330 Mini Monolithic</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H330</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
</tbody>
</table>
List of Linux drivers for BOSS-S1 Controllers

Table 8. List of Linux Drivers for BOSS-S1 Controllers

<table>
<thead>
<tr>
<th>Controller</th>
<th>Red Hat Linux 6.9 Driver</th>
<th>Red Hat Linux 7.4 Driver</th>
<th>VMware vSphere 6.5 U1 Driver</th>
<th>VMware vSphere 6.0 U3 Driver</th>
<th>SUSE Linux 11 SP4</th>
<th>SUSE Linux 12 SP3</th>
<th>UBUNTU 16.04.3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Embedded</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FD33XD PERC Dual</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td>FD33XS PERC Single</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td>HBA 330 Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td>HBA 330 Mini</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td>12Gbps SAS HBA</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
</tbody>
</table>

Installation and Configuration Notes

N/A